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1New  Features of
ArchiTECH.PC

ArchiTECH.PC ’23 
Article updated on October 17 2022

Compatibilities
ArchiTECH.PC is fully compatible with the Windows	11 operating 
system:

 z Supported version: ArchiTECH.PC	’23
 z Compatibles versions*:
-- ArchiTECH.PC	’21
-- ArchiTECH.PC	2019

(*) No update will be proposed in case of incidents related to 
Windows 11.

It is also compatible with files from SketchUp	2020, 2021 and 
2022.

New OpenGL 2D rendering engine
ArchiTECH.PC ‘23 benefits from a new OpenGL rendering engine 
allowing a spectacular	graphic	acceleration	of	 the	2D	display, 
a great fluidity in the displacements and the zooms, as well as 
the smoothing of the lines and the curves thanks to its integrated 
system of anti-aliasing.

1. Without anti-aliasing
2. With anti-aliasing

The performance improvement also concerns the opening or 
importing of large files (containing a large number of graphic 
elements such as lines, hatchings, dimensions, texts...), as well as 
the work on these files.
Like many CAD software, ArchiTECH.PC is now equipped with an 
intuitive	WYSIWYG	interface (acronym of What You See Is What 
You Get): what is displayed on the screen corresponds precisely 
to what will be printed.

Improved performance of the DXF/DWG and PDF import 
module
This module now allows the loading	of	very	large	files, containing 
a large number of graphic elements, thanks to a better optimization 
of memory consumption during this type of import.

2D view properties: new options
It is now possible to set the dimension in distance or pixels of the 
following element:
	z Text	outline	summits
	z Topographic	points
	z Arrows	of	reference	lines	(walls, slabs, hatching...)
	z Symbol	for	roof	reference	lines
	z Help	points
In addition to the possibility of changing the dimensions of the 
help points, it is also possible to change the line thickness.

Survey
	z Optim’BTP is a new plugin directly synchronized with 
ArchiTECH.PC. It allows the reading of the library of works as well 
as the edition and the reading of the estimates of Optim’BTP.

	z Redesign	 of	 all	 ODS	 templates and addition of new export 
templates by location.
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Wall tool
The new B17	Wall	 Tool	 -	 Join	 2	 walls	 by	 circular	 connection 
allows you to connect two walls by means of a circular arc in two 
clicks.

Left : before connection 
Right : after connection

Stairs
New line type parameter, which allows to differentiate between 
the overlap of the steps and the overlap of the staircase by floors.

New K-LINE entrance doors
18  new K-LINE entrance doors have been added to the door 
library. Each door is available in 2 models: single leaf and double 
leaf tierce.

ArchiTECH.PC ’21 
Article updated on November 29 2011

New Room Tool  
The new Room tool allows:
 z The creation of rooms based on regular or irregular polygons 
in a 2D or 3D view.
 z The location of rooms.
 z Automatic calculation of the surface area and volume of rooms.
 z The creation of standards. 
 z The generation of area tables.

3D Tools (Wall, Slab, Roof)
	z Bookmark tab :
Available in all 3D drawing tools, this tab allows you to add text in 
2D view to automatically drawn elements.

2D views
 z An optimization	 of	 the	 OpenGL	 engine has improved the 
display performance when moving and zooming in 2D views.
 z The display	 of	 projects is automatically refreshed after 
changes are made using the Line and Wall sub-tools. 
 z The management of selections/unselections	by	parameters	
has been optimized.
 z A context menu Locate	selected	elements, displayed with the 
right click of the mouse, has been added.
 z The display	 of	 projects is automatically refreshed after 
modifications made in 2D views and worksheets. 
	z Dimensions	smaller	than	1.00	m	can now be entered using the 
point or comma as decimal separator.
	z 2D	Textures: the display management of 2D textures between 
the foreground and the background has been modified and 
improved.
 z An option to show or hide	bookmarks in the 2D view properties 
has been added.
 z An option to move a plan using the 2, 4, 6 and 8	keys on the 
numeric keypad has been added.

Text Tool: Rich Text Format (RTF)
Rich Text Format (RTF) is an uncompressed format recognised by 
most word processing software. Now available in ArchiTECH.PC, 
this format allows:
	z the	addition	of	tables, images, photos;
	z the	choice	of	fonts, their size, alignment, indentation, colour,	
appearance (underlined, crossed out...), etc.

Bookmarks
 z ArchiTECH.PC allows to integrate texts using a font smaller 
than 8.
 z The display and movement of bookmarks in 2D views has been 
improved.
 z Bookmarks associated with 3D elements visible in the 2D view 
are updated instantly.

PDF: New Option
A drag and drop PDF vectorisation option has been added to the 
software.

IFC
The management of the preview	window of the IFC model before 
import has been improved. This window displays all the elements 
that will be imported into ArchiTECH.PC.

Optimizations
 z The import time of DWG files has been optimised.
 z The time taken to move	and duplicate elements from one floor 
to another has also been optimised.

Material Library (Works)
 z It is now possible to synchronise the Technical Specifications 
library with the Works library.
 z New partnership with Placo	 Saint-Gobain. Creation and 
integration of a complete PLACO brand library.
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New library objects
The steel	entrance	door models have new options to add:
	z A	fixed	fanlight	window
	z A	simple	or	double	fixed	sidelight	window
	z A	fixed	fanlight	window	and	a	simple	or	double	fixed	sidelight	
window. 
 
The Door tool has been enriched with new models:
	z Asymmetrical	double	doors

	z 3-leaf	sliding	doors

	z 3-leaf	pocket	doors

	z 4-leaf	sliding	and	pocket	door	(4 tracks)

	z 6-leaf	sliding	and	pocket	door	(3 tracks)

Project management
A new project	template has been added.

GPS
Evolution of ArchiTECH.PC GPS	data calculation to make it more 
accurate.

APCRender+
A semi-automatic synchronization of the ArchiTECH.PC	texture	
library with that of APCRender+ has been integrated into the 
program.

Automated tender management with SPIGAO
The direct link between ArchiTECH.PC and the SPIGAO application 
allows:
	z the	detection	of	tenders	in your geographical area;
	z direct	import	of	the	Breakdown	of	the	overall	and	fixed	price;
	z quantification	of	projects	by	simple	drag	and	drop;
	z analysis	and	comparison	of	the	result	with	the	quantities	of	
the	selected	tender;
	z the	publication	of	your	submission to this call for tenders.

Plugins
 z ArchiTECH.PC is able to identify materials that are no longer 
associated with plan elements when generating a sales document 
or an estimate.
 z Two new plugins have been created:
-- URS.
-- I-cost with Web	Services.

	z ONAYA plugin: the ONAYA software only accepts two decimals, 
so the number of decimals displayed in the plugin has also been 
limited accordingly.
	z Batigest: ArchiTECH.PC is compatible with the latest version 
of the Batigest software.
	z EBP: the Invitation	 to	Tender function has been adapted to 
the latest version of EBP.
	z Multidevis: the layout of imported estimates without titles has 
been improved.

Polish and Hungarian versions
A new management of the unit of measurement compatibility has 
been realized.

Windows compatibility
The compatibility management of projects made on different 
Windows versions has been improved.

Import/export
	z IFC: a specific compatibility with Revit software has been 
developed for the treatment of doors in ArchiTECH.PC.
 z An issue with importing	 PDF	 files that did not display the 
correct image has been fixed.
 z The file import window is compatible with high resolution 4K 
displays.

Online Help
The ArchiTECH.PC online help has been translated into English, 
Hungarian, Czech and Polish.
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ArchiTECH.PC 2019

New status bar management features
The status bar formerly appearing at the foot of every window has 
been moved to a fixed position below the menu bar independent 
of the current view, with content customisable as desired for each 
view type (2D, 3D, plot view).

Bar icon sizes and text font can also be configured to facilitate 
display on high-resolution monitors (2K, 4K, etc.).
Left-click/right-click mouse operation has also been replaced 
with the left-click/Shift+click system standard for Windows 
operating systems.

Non-modale dialog boxes
All of the following may now be displayed simultaneously:
	z Project	organization
	z Layer	setup
	z Element	palette	management
	z Element	parameters. This allows the user to step to another 
dialog box without closing the previous one.

Start page
When the program is launched, a dialog box appears, offering the 
following options:
	z open	a	recent	project
	z begin	a	new	project
	z open	a	template	file from the offered list.

Management of IFC files
 z Import with File	> Merge…
 z Export with File > Save	as > *.ifc.
 z IFC type parameter group for 3D drawing elements in IFC tab.
 z Manage IFC properties with the command Project > IFC	
Properties	Management.
 z Manage IFC styles with the command Project > IFC	 Styles	
Management.

Project organization
New menu command in the right-click menu of Project	
Organization for 3D view windows: 3D	 View	 Setup. The 3D 
settings were previously accessed by the Properties menu 
command; now this menu item displays the properties of the 3D 
view window.

Miscellaneous dialog box
New options in the Options > Preferences > Miscellaneous 
dialog box:
 z Error Signs parameter group: Disable Sound
 z Virtual Reality parameter group, Navigation window options: 

Show Image in Oculus Navigation Window, Oculus Navigation 
Window Width, Oculus Navigation Window Height.

Parameters of Gravitated Element dialog box
The use of the Parameters of Gravitated Element dialog box has 
become clearer. The program distinguishes between the current, 
highlighted item and the selected/marked items, so that possible 
actions are displayed on the buttons with clearer text.

Minor changes on user interface
 z View windows: Gray scaled icons in the upper left corner.
 z The way the selected items are displayed in lists in multiple 
locations in the program is changed. Previously, they appeared in 
red and now appear in bold type for better readability. 

Locations
New ways to manage your locations:
 z New menu commands in the right-click menu of 2D and 3D 
edit view windows : Select Location of Gravitated element, Set 
Location of Selected Elements.
 z New menu item in the Location Management dialog: File > 
Copy Location.

Stretching textures
You can also specify a negative value for the Stretch parameter 
for textures assigned to drawing elements, so that the texture 
applied to the surface is mirrored.

New objects
 z New items have been added in the Object library : OBJECTS\
SIMPLE	3D	CHARACTERS (30 items). Standing, sitting, walking 
and running models are built with few surfaces, with one texture, 
so they do not burden the 3D views even if they are placed in 
large numbers.

 z New item in DOORS folder: DOORS\Singles\Entrance 13 
(MAHJONG).

 

 z Other new entrance door models provided by different 
manufacturers:
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 z Two new door types in the object library (DOORS\SINGLES), 
which can be used mainly in loft and can be parameterized 
according to the roof angle: Loft	door and Loft	glassed	door.

 z Two new, configurable roof structure types have also been 
added: roof	structure	with	liveable	attic	space	incorporated and	
roof	structure	without	liveable	attic	space.

New wall settings
6 new built-in parameters are added to walls:
 z Gross left surface (LSuG): left surface without openings, but 
roof cuts and bottom slope are taken into consideration.
 z Surface of left side holes (LSuH): part of the opening outside 
the wall is not included.
 z Gross right surface (RSuG): right surface without openings, 
but roof cuts and bottom slope are taken into consideration.
 z Surface of right side holes (RSuH): part of the opening 
outside the wall is not included.
 z Gross surface (SuG): (LSuG +RsuG)/2.
 z Surface of holes (SuH): (LSuH +RsuH)/2.

Automatic dimensioning 
ArchiTECH.PC permits several walls, including walls with window/
door openings, to be dimensioned simultaneously, in a single step. 
Supplemental parameters can be used to configure dimensioning 
lines and the distances between them:

	z Full	dimension
	z Interior	dimension
	z Interior	dimension	and	door/window	axes

	z Interior	 dimension	 and	 perpendicular	 adjoining	 wall	
thickness.

Merging 3D Partplan files (*.PPL)
When merging 3D Partplan files (*.PPL), the content of the 
partplan will be automatically selected as the 2D views, so you 
can perform the desired transformation (eg. move).

Terrain tool
Improvement of terrain	platform	edge assignment:
 z Offsets could not be entered for the edges of the terrain 
platform.
 z The offset value assigned to the terrain platform edges was 
not visible in the drawing area if a value other than zero (0) was 
specified.
 z New functionality to copy terrain edge parameters to another 
edge with the Shift+C and Shift+V shortcut pair.

Render+
New saving file format in version Render+ to display projects with 
ArchiTECH.PC Viewer: *.	APJV.

Measurement
RTF file format supported in text boxes to increase compatibility 
with Codial management software.

Display
 z Increase in the number of visualization windows that can be 
opened.
 z The handling of container elements has changed, allowing a 
faster display in case of large files.

Worksheets
New option in the Worksheet	Properties dialog box for sections 
and elevations: Main	mode (Hidden	 faces, Hidden	 faces	+	3D	
hatching).

Sections and elevations
New option in the Section/Elevation dialog box: Text 
Horizontally. When this option is turned ON, the index text stays 
always in horizontal position.

Tool parameters
Drawing tool parameters are additionally accessible via a tree 
view located adjacent to the toolkit.  Parameters can be modified 
without interrupting the drawing operation.

Increased drawing précision
While drawing, the pending wall body is displayed from the start 
point to the current cursor position, permitting reference lines to 
be positioned precisely. The positions of walls with respect to 
reference lines can also be modified during the drawing process.

Ready element management
Some operations pertaining to ready elements can be performed 
in one step: modify selected ready element; delete or add material 
and/or attribute of selected ready element. 
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Ready elements configured for a given project are place in a 
dedicated system-level library, rendering it unnecessary to import 
them every time a new template is created.

New symbol for elevation drawing
Elevations are no longer created using the section line tool, but 
with a set of symbols provided specifically for the purpose.

Subtools allow to place and orient these symbols.



  
 

More intelligent cursor shapes
The cursor’s shape changes according to the current operation 
and the drawing element encountered:

1 62 73 84 95 10

1- Signals a wall reference line endpoint in default mode 
2- Signals a wall reference line in default mode 
3- Base cursor shape during data input 
4- Signals a hot spot during data input
5- Signals a hot line during data input
6- Signals a wall reference line endpoint during data input 
7- Signals a reference line during data input
8- Signals a hot line and its midpoint during data input
9- Signals a hot line and its midpoint during data input with angle measure 
locked
10- Signals the direction perpendicular to a reference line during data 
input with x-coordinate locked

Virtual viewing
By computing realtime stereo views, an Oculus headset 
connected to ArchiTECH.PC gives you the unique experience of 
total immersion in your 3D project.

Project thumbnails
Each project can be assigned its own thumbnail for display next to 
its name in the Windows file manager.

DXF/DWG Files
New option to open or merge DXF/DWG files: Preview > Designate	
detail. Clicking on the button opens a window allowing to select 
a detail to open.

Importation de fichiers PDF
The Resolution parameter in Import PDF dialog box (File > Merge 
PDF file) remembers the last used value.

Compatibility with SketchUp
SketchUp files can also be open the latest version of the program. 
When saving to *.SKP format, you can choose which version 
format to save in the dialog that opens.

ArchiTECH.PC 2018

New Terrain tool
Beginning with an altimetric point cloud (copied directly or 
imported in the form of a TRN file), ArchiTECH.PC can determine 
intermediate points in order to densify and smooth a terrain mesh 
by subdividing the surface.

x16                                                    x64                                                    x256

Improved contour lines
It is possible to generate contour lines whose interval can be 
adjusted according to the desired drawing precision.

25 cm                                                50 cm                                              100 cm

Sloping 
ArchiTECH.PC allows you to set slopes on each segment of 
a platform, and to modify the altitude of a point or a surface 
while acting on a zone that was predefined by using a selection 
polygon. The selected points can be saved in a TXT file in order to 
plot them on the contruction site, using a theodolyte, to prepare 
for the installation of buildings, land entries, etc.

Revamped Layer Manager
The Layers dialog box can remain open and visible throughout the 
entire preparation of a project (either on top of the current view 
or on a second screen), while its size becomes variable in order to 
display only the layers of the tool in use, or only the layers of the 
selected elements.
Layers can be displayed in alphabetical or numerical order or in 
order of their use.

Flashing 
Bands for valleys and hip joints as well as chimney flashings can 
be placed by simple mouse clicks on the corresponding edges.
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Metal frameworks
The metal girders available in the object library have been 
collected in a generic tool that allows you to arrange a series of 
purlins, rafters and battens at the same time in accordance with a 
predetermined layout.  

ArchiTECH.PC recognizes roofing holes (skylights or chimney 
ducts) and proposes treating them with headers.

The layout plan dialog box allows you to set an offset in relation to 
the underside of the roof in order to obtain the correct stacking 
of the different framing elements, irrespective of the type of 
profile chosen. The installation of the roof elements can be done 
at the same time for simple rectangular panels or parts of panels 
if irregular intervals between the elements need to be set. Taking 
roof breaks into account requires restarting with a new element.

Niches
Wall niches have been integrated into the ArchiTECH.PC object 
library. These include the shapes and the settings proposed for 
the free bays and allow a great diversity of shapes.

New Tools 
In addition to the features developed for this version of ArchiTECH.
PC, new tools are available that can enable you to work more 
quickly and efficiently, especially during modifications.

 Selecti	and	move with one click

 Sélect	and	copy with one click

 Move	only	the	clicked	element of a selection

 Copy	only	the	clicked	element of a selection

  Offset	a	polygon	segment according to a fixed value or the 
movement of the mouse; or move two segments beginning 
from the angle of a polygon depending on the movement of 
the mouse 

 Duplicate	the	selection with each new mouse click

 Cut	all	elements of the drawing according to a line 

 Cut	all	elements of the drawing according to a polyline

ArchiTECH.PC 2015

New view : worksheet
A section line on a project allows editing this section in a new view 
type: the worksheet. This sheet has 2D tools that allow completion 
of the section without switching betwee the project’s 2D and 
3D views. The dimensioning implemented in this worksheet is 
interactive with the modifications made in 2D/3D views. 

Other worksheets can be created by all types of 2D drawing 
(sketchbook, record of works executed, schematic diagrams...).

Save floor settings
The organization of the floors of a project can be saved in order 
to be used in other projects. If the imported scenario contains 
more floors than the current project, new floors are created 
automatically. In the opposite case, the floors are then deleted.

Savec a work area
A work area in a zoomed part can be saved and recalled at any 
time during a session, with the option of locking it or not. A very 
useful command when working on large files in DWG or PDF 
format.

Adjustment on perspectives of photos
In a few clicks, transform photographs of buildings (viewed in 
perspective) in geometral views (front views) with scaling, for 
the purpose of surveying, estimates, etc. Adjusted photos can 
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be resized and added to each other in order to carry out the 
deployed buillding.

Photo Match
This function makes it possible to carry out photomontages 
with very precise insertions on site by calculating the observer’s 
position beginning from the vanishing points of the photos used 
for this effect.

Hatching reference lines
Option of displaying reference lines of hatched surfaces.

Grouped settings for reference lines
Option of setting the type, color and thickness of reference lines 
for slabs, hatchings, and arcs.

Emissive textures 
The surfaces of a project will then have the option of diffusing 
light thanks to the texture’s emissivity setting.

New objects with adjustable settings
	z New	chimney	stacks

	z New	 chimney	 stacks	 starting from strokes made with the 
line and arc tools. Afterwards the parameters are used to define 
the depth of the basin, the water depth, dimensions of ledges, 
ladders and stairs as well as the textures of each element.

	z Exterior	lighting	
	z Bathroom	furniture
	z Hip: placed in 2D or 3D, it automatically adapts to the roof 
pitch.
	z Cornices	and	eaves

ArchiTECH.PC 8

New tools
	z Frames: A function to lay purlins, rafters and battens by parts 
of the roof section, thus facilitating the layout of complex roofs.
	z Help	Points: A function to place help points taking into account 
the total distance between two clicked points, the offset of the 
first point from one side of the element (slab, roof, wall, etc.), the 
interval between each point, the desired number of points, and 
the last interval.
	z Woodwork: Possibility of associating handles to woodwork. 
Setting the type of handle, escutcheon and lock.

Displacement mapping
A feature that generates true relief on flat surfaces by using 
simple textures (displacement mapping) to simulate wave tiles, 
clapboard wood, metal siding, stone walls, grassy areas, etc.

Drag and drop and copy/paste textures in 2D and in 3D
 z Feature allowing drag and drop of cropped images (PNG 
format) on the final rendering in order to personalize them quickly, 
without going through image processing software.
 z Integration of an image editor which allows:
-- enlarging/reducing	the	calculated	image;
-- moving/pivoting	an	imported	image;
-- manage	foregrounds	and	backgrounds;
-- register	 the	 fitting	 of	 a	 current	 image as a work file 
(proprietary format) to resume later.



9New  Features of
ArchiTECH.PC

Compatibility with ArchiWIZARD
In dynamic relationship with ArchiTECH.PC 8, ArchiWIZARD 
calculates the bioclimatic need during the design phase of your 
projects. 
ArchiWIZARD linked with ArchiTECH.PC 8, delivers the thermal 
calculation note at the end of the project.
Equipped with the calculation engine developed by STCB (French 
Scientific and Technical Centre for Building), the software 
ensures bioclimatic need, primary energy consumption and the 
comfortable indoor temperature calculations for your projects.

2D and 3D acceleration
ArchiTECH.PC 8 runs in OpenGL in 2D views, allowing quick 
manipulation of large files containing a large number of lines and 
shading in DXF and DWG.
ArchiTECH.PC 8 greatly accelerates the display of 3D views 
through the continuous storage of 3D view components. Updates 
of modified, added or deleted components are instantaneous.

PDF import
 z Conversion of images when opening PDF files.
 z Option of scaling the imported file with a geometrically similar 
ratio of length and width, if necessary.

Integrated DevisCAD
 z Plans, facades, sections, perspectives, detail booklet, 
written documents (bill of quantities and estimate, technical 
specifications) are treated as views and are an integral part of the 
project in  ArchiTECH.PC 8.
 z ArchiTECH.PC 8 provides a report	generator to lay out and 
customize different types of editions as needed for all written 
documents.
 z Plug-in allowing work	 in	 connection	with	 external	 software	
specifications (many types of French bill of materials software 
: for link to any other software, contact us) in order to associate 
library materials of the external software to the plan and to 
generate the estimate directly.
 z ArchiTECH.PC 8 can also generate data in desktop tools such 
as Microsoft Excel, Word, Project and LibreOffice.

3D Edit Mode 
Textured 3D views now allow modeling and changes to the 3D 
model of a project.

Drag and drop and copy/paste textures in 2D and in 3D
ArchiTECH.PC 8 allows copy/paste and drag and drop of textures 
directly on different sides of a project in 2D and 3D views.

Post processing
Various tools for image correction are available to allow you to fine 
tune brightness, contrast and intensity of your 3D renderings (tone	

mapping, white	 balance, editing	 curves, gamma	 correction). 

BEFORE		 				 				AFTER

ArchiTECH.PC 7

2D Textures
The textures and/or hatchings assigned to the drawing elements 
can be displayed in the 2D view. These textures or hatchings can 
be made partially or totally transparent to show the details of the 
drawing (objects, dimensions, texts, etc.).

Insertion in the site
The insertion in the site can be done directly from the 3D view 
by displaying the picture of the building plot in the background 
of the project.
The project is then positioned and oriented on the background 
image using the ArchiTECH.PC navigation tools. When the project 
is correctly inserted, the final image can be calculated.

Clipping and image retouching
If the insertion of a project into the site hides some elements 
of the photo that should remain in the foreground (trees, 
vehicles, etc.), there are features that allow you to make 
the project partially transparent in order to cut out these 
elements and put them back in the foreground of the view. 
Other features allow you to retouch the view for the calculation of 
the final image: positioning of shadows or modification of textures.
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Copy/paste quantities
This new feature allows you to start a quantity survey or an 
estimate without any prior settings or library of works.
A right click of the mouse on an element of the project (e.g. 
insulated wall of 36 cm thickness) allows to select all the identical 
elements. A second right click on this selection displays a table 
of quantities.

This table of quantities remains open when one passes from 
ArchiTECH.PC in your usual software of estimate or office 
automation in which exists a model of estimate all trades.
It does not remain any more but to copy the result of the selected 
formula, and to paste it in the field Quantity of the corresponding 
work.

Staircases
 z All staircase models allow the use of a central	stringer.

 z The numbering	of	the	steps is also possible.

New library objects
New customizable objects have been integrated in ArchiTECH.
PC :
	z Transom	doors	and	windows

 z Roof window on glass sill
	z Roof	window	on	door

 z Solar panels

Import and export
It is possible to import and export new objects in 3DS format.

Survey of building sites
In Bluetooth connection with a laser	meter or a Leica Builder 
Station, ArchiTECH.PC resizes the sketches of the rooms drawn  
freehand on the screen.

Roofing surveys are done from the ground where each slope is 
calculated by measuring the elevation of three specific points. 
The layout of the roof plan will take the slope defined by these 
three points.

The survey can be saved in DWG format to be exported to other 
CAD software or processed by design offices.

Line library for the representation of networks and boundaries
ArchiTECH.PC 7 has a library of customizable lines for the 
representation of different networks, systems and terrain 
boundaries.
	z Networks:
-- Water supply system
-- Severage system
-- Rainwater
-- Domestic sewage
-- Foul waste water
-- Domestic hot water
-- Steam
-- Heating system
-- Gas supply
-- Electric power distribution
-- Telecommunication networks

	z Limits:
-- terrain
-- Buildable area
-- Fencing

Render+, new 3D imaging
ArchiTECH.PC 7 features a new global illumination rendering 
engine, Render+, to increase the photorealism of your images. 
Render+ takes into account the direct (light sources) and indirect 
lights of a project (incidence of light rays bouncing on different 
surfaces, according to their brightness).
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A new material editor also integrates the parameters dedicated 
to Render+ for the customization of surface effects from textures 
(brightness, transparency, reflection, refraction...).

ArchiTECH.PC 6

New interface
Graphic redesign of all tools, sub-tools and dialog boxes for a 
better reading of the functionalities.

Networking
Professionals collaborating on the same project (architects, 
engineers, draftsmen...) do not necessarily work in the same 
place and/or at the same time. Such an operator can ask for 
the centralization of the data processed by one or more of 
his colleagues located in other offices, even in other cities or 
countries. ArchiTECH.PC 6 allows you to prepare and organize 
this team work in a local network or via the Internet.

Ready elements/Prototypes
For all elements of the model, it is possible to create directories 
and sub-directories of Ready elements/Prototypes. Ready 
elements are elements saved in the template file (Untitled.apt) 
which store all the tab settings of the concerned tool (wall, slab, 
roof, etc.). They are available for each new project. These Ready 
elements contain the most frequently used settings, in order to 
avoid the need to re-set all the recurrences later. It is therefore not 
necessary to redo the settings of the element to be drawn each 
time: it is sufficient to place the corresponding Ready element/
Prototype in the project.

Prototypes are the history of the elements of the current project. 
They can be saved and organized in a tree structure. Modifying an 
element in the tree structure causes all identical elements in the 
project to be modified.

Location
With the Project > Location	 Manager command, the various 
elements of a project can be assigned to locations structured in 
a tree structure.

The location scenarios can be saved by type of project, and 
recalled for any new project. This allows the generation of 
estimates, work	contracts and planning with the location of the 
works or, conversely, the details of the works by location.

Working in 3D views
The menus of the 2D and 3D environments are identical and 
synchronized. This allows the entry of information in the 3D views, 
using the same tools as in the 2D view. This feature is particularly 
useful for complex models, such as roofs and terrains.

The 3D input allows you to work on any floor of a project without 
having to change levels. It is also possible to simultaneously modify 
selected elements on several floors at the same time. Information 
entered in a 3D view automatically updates the corresponding 
2D view. Editing is possible in Color, Wireframe or Hidden	Faces	
mode, with the 3D window automatically displayed with one of 
the latter. In addition, ArchiTECH.PC 6 allows the saving of layer 
settings and the recall of scenarios on a project by project basis 
(same as in 2D view).

Ghost floors
In addition to the current floor in the 2D view of a project, this 
feature allows to see the other floors, upper or lower (or only 
part of these floors), in order to check the overlapping of their 
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respective structures. Hotspots and reference lines of the 
elements present on the ghost floors are recognized.

Display variants of elements or textures as thumbnails
Some elements in the libraries have variants that can now be 
quickly selected using preview thumbnails in drop-down lists, 
such as types of closures (doors, windows) or representations 
(stairs).

Library objects and textures are classified by directories in their 
respective dialog boxes.

New Status bar
Organized in a double line, the status bar integrates the commands 
Shift, Show	ghost	 floors for the 2D mode, and the commands 
Switch	 to	 Edit/View	 mode, Switch	 grid	 to	 visible/invisible	
mode, Show/hide	origin	marker, Lock/unlock	view, Lock/unlock	
camera for the 3D display mode.

Shutters and lintels
Doors and windows are completed with two new parameter 
groups:
	z Shutters: swing shutters and roller shutters. Roller shutters 
with interior/exterior/wall-mounted boxes are present in the 
program.
	z Lintels of various types, with special parameters for the 
creation of the metering. Different types of lintels can be 
associated with the frames.

Floor designations
The names and floor numbers are now displayed in the title bar 
of the program.

New intersection pointers
In order to limit the use of help points, intersections are 
automatically recognized. All cases have been considered: line/
line, line/circle, line/face	intersections, etc.

New mouse use
The basic principle of the mouse click has changed. In the new 
version, the drawing of plane elements starts when the mouse 
click is released, not where it was initiated.

2D Environment
	z Wall	tool: The types and colors of lines separating each layer 
of a composite wall can be defined by the user.
	z Object	 tool: The position of a roof window is determined 
automatically by simply recognizing the slope and altitude of the 
clicked point.
The setting, the distribution and the position of the purlins, rafters 
and battens is automatic for each roof section (frame modeler).
A 2D object can be extruded along a polyline, with automatic 
angle junction (e.g. cornice around a building).
It is possible to add or remove the angle of an object extruded 
along a polyline. The extrusion path of a 2D object following a 
polyline can be modified (e.g. modification of a segment in arc, 
or conversely).
	z Staircase	tool: It is possible to draw a free staircase according 
to its walkline or its stairwell drawn with the Line or Arc tools. But, 
with these same tools, the staircase can also be drawn taking into 
account both the walkline and the stairwell.

It is possible to transform walklines represented by broken lines 
into arcs and/or arcs into broken lines.
The contours of a stairwell can be transformed from lines to arcs 
and/or from arcs to lines, and the sway of each step corrected 
punctually.

	z Roof	tool: The reference line of a roof can be shifted from its 
starting point.
It is now possible to draw a roof passing through 3 points. This 
feature is very useful in the case of projects on old buildings with 
non-parallel and/or non-perpendicular walls (sloping edge lines).

The slope of the roof slabs can be modified: vertical, horizontal, 
perpendicular to the slope, or at a given angle.
An integrated framework modeler allows the parameterized and 
automated input of the different elements (purlins, rafters...).
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